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Prelab: 

1. Read the How to Make a Good Graph pages in your course packet.  An additional section about 

graphing is in your text, Appendix A.  Define “independent” and “dependent” variable, and on 

what axis they should be placed. 

2. Make a graph, BY HAND, on graph paper (in back of this booklet) for the data below, which was 

determined by finding the mass of a rope that was cut at specific lengths.  Make sure that you 

read the how to make a good graph sections and follow the examples at the end of this document 

(page 10 or so). 

length (cm) 10.0 15.0 20.0 25.0 30.0 35.0 45.0 55.0 

mass (g) 19.1 35.2 39.9 54.4 69.6 78.8 99.7 116.4 

 

3. Using the graph of the data above, determine the quantitative relationship of mass to length (the 

slope) and express as a sentence, with measurements and units.  

4. Use this information to find the mass of a piece of rope which has the length of your date of birth, 

in inches. 

5. Read the section on density in your text, AND the introduction below.  Write a definition for 

density, and explain why the density of water has a value that is easy to remember. 

6. Calculate the density of an object that has a mass of 79.2 g and a volume of 95.2 cm
3
? 

7. Read the online directions for using Graduated Cylinders, Pipets and Analytical Balances.  
   http://academic.cuesta.cc.ca.us/gbaxley/chem1A/volume/prelab_reading_for_week_2.htm 

What are the proper accuracy levels for graduated cylinders and pipets? 

 

Questions to consider while performing this lab: 

� Do all devices record identical values? 

� Does each piece of chemistry glassware measure volumes to the same precision? 

� Can the density of a solution be determined via a standard calibration curve? 

 

Introduction: 

When writing a measurement:  

� always include both the number (eg. 22.3) and the unit (eg. cm) 

� always write down the correct number of digits (digits that you know plus one estimated).   

Your instructor will demonstrate how to determine how many digits to include. 

 

What is Density, and How is it Useful? 

Were you ever caught by the riddle “what weighs more, a pound of feathers or a pound of 

lead?”  They each weigh the same, of course, but ask the joker which they would prefer to have 

dropped on their foot!  The reason why this riddle is amusing is that even though a pound of one 
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thing weighs the same any other, the density of the lead is much different.  The density is a ratio of 

the mass over the volume for a substance.  It is an intensive property, meaning that density doesn’t 

depend on how much of the sample is being measured.  The mass any block of lead divided by its 

volume will yield the same ratio, regardless of the size of the block. 

 

Because most substances increase in volume as their temperature increases while their mass 

stays constant, the ratio of mass to volume (density) decreases.  This is why density is also reported 

with a temperature.  Gasoline is sold on a “per volume” basis.  Do you get more mass for your dollar 

when buying gasoline on cold days or hot days? 

 

Density is fairly easy to measure, and is an important indicator for certain biological fluids.  

Urine density is analyzed as one indicator of a type of diabetes, and also for dehydration, infection, 

and renal failure.  Blood donors typically have their blood tested by the “float test,” where a drop of 

blood is tested for hemoglobin (and therefore iron) content by observing its density compared to a 

copper sulfate solution. 

 

Density is also used to express the concentration of solutions.  A 5.0% weight/weight solution 

of NaCl means that there are 5.0 g of NaCl in 100 g of solution, or 5.0 g of NaCl in 95 g of water.  

The 5.0% solution could also be made with 50.0 g of NaCl and 950.0 g of H2O.  We will study other 

units for concentration later in the year. 

 

In today’s lab, you will:  

� Analyze student data from different measuring devices to determine if one device is more 
accurate or precise than the others. 

� Determine the density and concentration of a solution by a common analytical method: using 

a calibration graph made with known volumes and concentrations of solutions. 

 

Safety: 

Although the solutions used today are relatively harmless, GOGGLES and APRONS will be worn at 

all times.  All solutions can be disposed of in the sink. 

There is a data sheet at the end of this handout for your measurements.  Record all data in INK. 

 

Part 1:  Graphing  (may be done at any time in lab) 

Check out a lap top computer, log on as 2105 (no password needed) and start Microsoft Excel.  

Unfamiliar with Excel?  There is a step by step Excel guide in the course packet starting on p. 14.   

 

Using an application like Excel is very helpful for science and engineering majors, so if you are not 

familiar with how to use Excel make sure that you learn today. 

Answer the graphing questions on p. 11 before leaving lab.  Check your answers with your instructor. 
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Part 2:  Determination of the Concentration of a Solution by Density    

A.   Data collection    (in class)   

1. Rinse and dry 2 100 mL beakers and record their masses to the nearest 0.001 g in Table 1.  Mark 

the beakers with tape for easy identification. 

2. Obtain about 50 mL of one of the unknown solutions in a clean, dry 150 mL beaker. 

3. Using the pipet bulb, fill the 10 mL volumetric pipet with about 2-3 mL of the unknown solution.  

Rinse the bulb of the pipet with the wash, and discard.  Rinse twice more. 

4. Using good pipet techniques, fill the pipet with the unknown solution so it’s above the etched 

mark.  Wipe the tip of the pipet with paper towel, hold the tip against the beaker, and allow to 

drain to the mark.   

5. Holding the tip of the pipet against the weighing beaker, allow the pipet to drain completely, 

except for the last drop that does not drain by gravity.  Repeat to deliver 10 mL of the solution to 

the second beaker. 

6. Weigh the beakers separately, recording the masses of the beaker + solution.   

7. Calculate the masses of the solutions.   

 

B.   Determining the Concentration of the Unknown Solution    (in class)   

The density of aqueous (dissolved in water) solutions of salts is related to how much of the salt is 

dissolved in a given amount of water.  The densities and of several calcium chloride solutions are 

provided for you in the table below.   

Percent by mass 1.00 8.50 14.00 22.00 32.00 40.00 

Density (g/mL) 1.008 1.080 1.120 1.198 1.310 1.39 

Using the information in the table, the concentration of any calcium chloride solution can be 

determined once its density is measured.  The density of an unknown solution of CaCl2 will be 

determined using a pipet.  Preparing a calibration graph of the density (easily measured) of the 

known solutions will allow the concentration of the unknown solutions to be determined. 

8. Calculate the density of the unknown solution using your data in Table 1. 

9. Check out a laptop computer, log on as 2105 (no password needed) and start Microsoft Excel.  

Prepare a graph of the density and concentrations of the calibration solutions above using MS 

Excel.  There is a step by step Excel guide in the course packet starting on p. 14.  Each student 

should prepare their own graph from a blank Excel worksheet DURING class. 

10. Before finalizing your graph, consider these questions: 

a. What are the independent and dependent variables?  Which axes are appropriate?   

b. What sort or relationship exists between the density and concentration? 

c. Use both an extrapolated line on the graph paper and the equation for the line to 

determine the concentration of salt in the solutions of unknown concentration.  
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Part 3:  Comparing the Precision and Accuracy of Two Common Measuring Devices   

In a previous semester, students collected density data for two types of Snapple drinks, Regular 

(sweetened with sugar) and Diet (artificially sweetened).  Two measuring devices were used to 

measure the volumes of the liquids, 50 mL graduated cylinders and 10.00 mL volumetric pipets.  The 

goal of the experiment was to determine which device was more precise, and if there was a difference 

in densities of the two kinds of drinks. 

 

11. Open the Density Comparison Excel file by opening from the desktop: 

My Computer_chemistry on labvol….(Q:)_Baxley_Density Comparison for Accuracy and Precision.xls 

12. Use Excel to calculate the average and standard deviations for each of the columns of data.  Help 

with formulas is on page 17.       
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Name  __________________________________  lab day/section _______________________ 

 

partner  ___________________________________    ____________________________________ 




��������
����	����:    answer in lab



 

The temperature of a water sample was measured with 2 thermometers, one in Celsius and the other in 

Fahrenheit.  The design of the experiment was such that the temperature of the water was measured at 

every 20 °C increase, as ice water was heated to boiling.  The data are given below: 

 

T  °F 32 68 104 140 176 212 

T  °C 0 20 40 60 80 100 

 

Prepare a graph for the data above using MS Excel, and answer the following questions about the graph. 

Make sure to follow the guidelines for using Excel and making good graphs in this lab manual.   

Print the graph and attach after this page, but do not print with a gray background! 

 

G1. Which is the dependent variable?  Why? 

 

 

 

 

 

 

G2. Find the linear relationship between °F and °C.  Record the equation for the line using y and x, and 

also translate these variables into °F and °C.  Include correct units. 

 

 

 

 

 

 

G3. Explain in words the meaning of the slope and y-intercept values determined from your graph. 

 

 

 

 

 

 



 6 

G4. Using the equation for the line, what value of °F will be equal to 37.0 °C?  (show your work) 

 

 

 

 

 

 

 

G5. Using the equation for the line, what value of °C will be equal to 145 °F?   
(this is about the threshold temperature of pain for most people) 

 

 

 

 

 

 

 

G6. The equation for calculating the temperature in Kelvin from degrees Celcius is exactly the same as 

the equation that would describe the best fit line of a graph of temperature in K vs. °C.  What is the 

slope of this line? 
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Table 1:  Mass and Volume for Unknown salt solution:        attach graph after this page 

Unknown ID:  _______________ Trial 1  Trial 2  

Mass beaker    

Mass beaker + liquid   

Mass liquid   

Volume   

Density   

Concentration  (% by mass) 
(from graph, see procedure section for data) 

  

 

sample calculations for density of unknown and concentration of unknown (from graph): 

 

 

 

 

 

 

 

Using the equation of the line from the graph, what would be the density of a 54.0% CaCl2 solution?  

Show your calculation below. 

 

 

 

 

 

 

 

 

Using the equation of the line from the graph, what is the concentration of a solution with a density of 

1.24 g/mL? 



 8 

���	
!�
���"�����
���
�����	�
����	�����

 

1. Use the class data to compute the mean (average) density for each data set (each beverage, by 

each measuring device.  See p. 17 in the course packet for how to make Excel do this for you!  

Enter your results in the table below. 

 

Regular drink Diet drink  

Grad. Cyl. Pipet Grad. Cyl. Pipet 

Average     

Standard 

deviation 

    

     

 

2. Evaluate the graph showing the ranges of the density data for each of the two measuring devices.  

Based on the graph, which device is more precise?  Cite examples from the data, and include a 

definition of precision in your answer.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Is it possible to determine which device is more accurate?  Be specific, and cite data.  
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4. From the data collected by the class, compare the densities of the diet and regular beverages.  

Which drink is more dense?  (cite data) 

 

 

 

 

 

 

5. In terms of the ingredients of drinks sweetened with sugar compared to aspartame (one artificial 

sweetener), why would the densities be different between regular and diet drinks?  This may 

require some research on your part.  

 

 

 

 

 

 

 

 

 

 

 

6. Will an object that is 0.332 kg and 42.0 cm
3
 float in 10.0 L of liquid with a mass of 7.9×10

3
 g?  

 

 

 

 

 

 

 

 

 

 

 

7. A standard issue U.S. Federal Reserve gold bar measures 7.00 × 3.625 × 1.75 inches.  If gold has 

a density of 19.3 g/cm
3
, what is the mass of a gold bar in kg and pounds?  
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8. On a ‘Nick at Nite’ rerun of McGyver, the villain is shown pushing a snow sled upon which is a 

pile of gold bars that is about 1 m
3
 in size.  What mass (in pounds) would this stack of gold 

weigh?   

 

 

 

 

 

 

 

 

 

 

9. Briefly describe the feasibility of the villain pushing the sled full of gold across a field of snow. 

 

 

 

 

 

 

 

 

 

10. Gasoline has a density of about 0.680 g/mL at 20 °C.  What is the mass of 15.0 gal. of gas? 
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Graphs can be a useful way to represent data (a picture is worth a thousand words).  Often just listing 

the data in a table does not show trends as well as a graph.  The ability to draw and interpret graphs is 

necessary for almost all disciplines. 

 

1. First, make sure that your data is in a convenient form.  Prepare a table with the data in columns 

that are labeled with the type of information and units in that column.  For example, column 

headings might read “time (min)” and “distance (cm).” 

 

2. Not all graphs need to begin at 0,0.  If the data doesn’t include numbers close to zero, choose the 

next lowest number that is easy to use (multiples of 1, 2, or 5).  Look at the range of numbers to 

be graphed and choose the best scale interval to fill as much of the page as possible, but using 

multiples of 1, 2, or 5.  The x and y axis do not need to start at the same value or have the same 

scales.  This is probably the hardest part of making a graph.  Label each major gridline (usually 

the thicker lines) with the appropriate number. 

 

3. Label each axis with the data and units being graphed.  The x-axis is the horizontal axis and the y-

axis is the vertical axis.  The independent variable goes on the x-axis.  That is the variable that 

you knew before you did the experiment.  For example, if I rolled a ball and measured its distance 

every 30 seconds, “time” would be the independent variable and go on the x-axis and “distance” 

would be the dependent variable and go on the y-axis.  Another guide is that the independent 

variable is the one you are most sure of. 

 

4. Plot the data by drawing a small dot for each data point. 

 

5. If the graph is linear, draw the best straight line through the points with a straight edge.  The line 

may not necessarily run through all, or any, of the points, but is an average of the points.  DO 

NOT simply connect the first data point with the last data point, and DO NOT connect the dots.  

If the graph is not linear, draw the best smooth curve that you can through the data.  Again, do not 

connect the dots; the curve may not go right through every point. 

 

6. Add a descriptive title to the top of your graph.  Describe the experiment; don’t just list the 

variables.  Time vs. Temp is not very informative. 

 

7.  To determine your slope, find two pairs of points on the line that are near your first and last data 

point.  DO NOT simply use two of your data points, unless they are EXACTLY on the line.  

Calculate the difference in the values for the y axis points, and then the difference in the x axis 

points.  Divide the y axis difference by the x axis difference.   

 

  slope 

Y2 − Y1  =  slope  (include the units of the y and x axes) 

X2 −X1  

 

The slope likely has units!  In the graph below, the units are m/sec, so the slope would be  

given as 1.5 m/sec. 
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If your graph is computer generated, you need not recalculate the slope by hand, as most graphing 

applications will generate a best fit line and equation for you.  However, you must understand what 

the equation means.  Below, the equation for the line might be   “y = 1.5x + 12”  The equation must 

be written with appropriate symbols,   d = 1.5 (
 m 
 s )×t (sec) + 12 m  AND real words, “the distance 

traveled in meters is equal to 1.5 times the time, in seconds, plus 12 meters.”   

 

Below is a sample graph.  It satisfies all of the criteria for a good graph, except that it is too small.  

Ideally, the graph below would be printed in landscape mode, at full page size. 

 

Time vs. Distance for a Steel Ball
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Sample Graph 

 

Graphs will be graded on the following criteria: 
 

1. Title, describing what is being graphed 

2. Both axis labeled in terms of their measured values, with units 

3. Good scales and intervals 

• Not all graphs need to go through 0,0 

• Origin (starting point) is multiple of 1, 2, or 5 

• Intervals are multiples of 1, 2, or 5 

4. Scale intervals linear and appropriately labeled 

5. Independent variable on x-axis; dependent variable on y-axis 

6. Data area of the graph takes up as much of the page as possible 

7. Best fit linear or smooth line (as appropriate), not necessarily through points but an average 

8. Correct determination of slope, with units 

9. If graph is computer generated, I also look for: 

• A legend so it’s easy to see what has been graphed 

• Include major and minor gridlines OR tick marks on both x and y axis 

• Not crowded (not too many gridlines or ticks) 

Determination of the velocity of a steel ball. 
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10. Equations written for linear plots must be written with symbols for the variables on each axis, 

and include appropriate units.  (see above) 
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Both graphs should be printed at least ½ page size! 

 

 

Changes in a volume of a balloon when heated

y = 2.1848x - 16.071
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The good:  The graph above shows a good linear relationship between the data, with a perfectly 

straight line that fits the data as well as possible.  The axes are well labeled, and the scale/tick marks 

are perfect.  Note how the data points take up most of the area of the graph.  The equation for the line 

is printed, and the student provides an explanation in words. 

 

The bad:  The y axis has too many minor tick marks; they are just a blur. 

 

Change in Conductivity of a Cu wire when heated
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The good:  The graph above shows a curve fit for the data, with a smooth curve that fits the data as 

well as possible.  Neither graph is “connect the dots.”  The x axis is well labeled, and the scale/tick 

marks are perfect.   

 

The bad:  The y axis is not labeled with units for conductivity.  The x axis extends too far out. 
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Microsoft Excel is a spreadsheet program that allows you to organize data, perform repetitive calculations, and 
create graphs.  It is a very useful program to handle scientific or statistical data, to create databases (lists of 
information such as an address book or a library catalog) or to do accounting. 

This handout is a guide fo how to enter data, perform calculations and make graphs with Excel.  All tabs and 
menu selections are shown in bold italics.  Make sure that “How to Make a Good Graph” is consulted. 

1.  Entering the data. 

1. Start up a computer, log on to the computer as 2105.  You may want to bring a USB disk to save your 
graph.  Click on the Microsoft Excel icon.  A blank data sheet should now appear on the screen:  

2. It’s helpful to enter the names and units of your data in the cell above the column of data.  Columns can be 
widened with a left click on the line to the right of a column heading, then dragging the line.  Or, double left 
click the right hand line to the right of a column heading. 

3. Enter x,y data in side by side columns, with the x axis data in the left hand column and the y data to the 
right, but this isn’t necessary.  Press the “Enter” to move down a cell, or use an arrow key or the mouse to 
move to a new cell. 

4. You can make Excel calculate values with equations you enter.  Start with = in the cell, then use standard 
arithmetic symbols.  You can use SUM, LN or LOG, STDEV, or SQRT (+ others).  The cell would read:  
=SUM(A1:A3) to add numbers in a range of 3 cells (A1+A2+A3).  Use lots of brackets ()., see the 
Formulas page, p. 17. 

2. Graphing the data. 

5. To select the data to plot, left click on the top left cell and drag to the bottom right cell.  All the cells in both 
columns containing data should now be highlighted.     

6. Click the Insert tab and then the Scatter Chart button (see below).  The type of plot you need is an XY 
(scatter) plot with with only markers (no line). 

7. Check your graph carefully to make sure the proper data is on the x axis.  If the x data is on the y axis, 
right click in the chart area and click on Select Data.  Click the Edit button and change the letters in the 
series X values and series Y values fields. 

8. Add Titles and Axis labels:  Click on the chart to outline in blue, and select the Layout tab under Chart 
Tools. 

a. Click Chart Title and Above Chart, then add your descriptive title (not simply y units vs. x units).  
Highlight the title with the mouse, and reduce the font size to something reasonable (12 or 14 pt). 

b. With the chart selected, under the Layout tab in Chart Tools, click Axis Titles and enter titles and 
units for the x (horizontal, title below axis) and the y (vertical, rotated). 

3. Best-fit line and correlation coefficient. 

9. With the chart still selected, click on the Design tab under Chart Tools.  Use the left mouse button to 
select one data point, then right click.  Select Add Trendline.  Make sure the “linear” box is checked, and 



 16 

check the 2 boxes at the bottom (Display equation on chart, and Display R
2
 value on chart).  Close the 

window. 

The R value indicated on your graph is the correlation coefficient.  The value of R
2
 gives an indication 

of predictive value of your equation, and extent that variance in y depends on x (and not other factors).  
The closer it is to 1.0 the more predictive value of your data. 

10. Select the Legend box and delete. 

4.  Add tick marks and adjusting the axes. 

11. To add minor tick marks, right click a number on an axis, and select Format Axis.  Select “Inside” in the 
menu for Minor tick marks.  The scale of the tick marks can also be adjusted to add more or remove some 
of the marks.  The scale of the axis can be adjusted to maximize the space for the actual data in the chart 
window.  The placement of the x axis can be adjusted in the y axis formatting box, useful for graphs with 
negative y axes. 

 

 
 

5.  Sharing work 
It is expected that you and your lab partner will have identical data (you’d better) and, therefore, have 
identical graphs.  Many of you will work with your lab partner on the graph.  This is OK, as long as both 
of you are actively involved in making the graph.  You are NOT LEARNING if your lab partner is creating 
the graph, printing out two copies and giving one to you.  You are paying money to learn, don’t waste the 
opportunity.  May you be cursed with lousy jobs and sleepless nights if you don’t take advantage of your 
chances to learn. 

 
If your graph is computer generated, you need not recalculate the slope by hand, as most graphing 

applications will generate a best fit line and equation for you. 
 
There are two sample graphs on the next page. 
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There are several ways to make superscripts and subscripts.  If you are not using your own computer 

and/or you don’t want to change the settings on the computer, use method #1.  If you would like to 

change the settings on your computer and would like to set up a quick method, use method #2. 

 

Method #1 

1. Type the text without subscripts or superscripts (eg: H2O) 

2. Highlight whatever you would like to super- or sub- (eg: H2O) 

3. In the menu, click on “Format” the “Font.” 

4. In the middle of the box, you are given several choices of “Effects.”  Click on the one you want to 

put a check mark in the box.  Click “OK.”  You’re all done!  (eg: H2O) 

6. Immediately after subscripting one number (before you type anything else), you can highlight the 

next number (or letter) to be subscripted.  Then click control-y.  This will repeat the last 

formatting.  This works for super-scripting as well. 

 

Method #2 

1. This method will put icons in your toolbar for superscript and subscript.  The icons will always be 

there, unless you take them off, even after turning your computer off and on again.   

2. Click on “Tools” in the menu bar.  Towards the bottom, click “Customize.”  Under “Categories” 

on the right, click “Format.”  Under “Commands” on the left, scroll down until you find “x
2
 

Superscript.”  Click-hold-and drag this icon into your toolbar wherever you’d like it placed. 

3. Repeat step 2, but drag the “x2 Subscript” icon into the toolbar next to the superscript icon. 

4. Now you’re ready to type.  The new icons will toggle between plain text and super- or subscript.  

For example, if you want to type H2O, type “H” the click “x
2
” icon, type “2”, click “x

2
” again, 

then type “O”.  Or, if you’d prefer, you can type everything in without supers and subs, then 

follow the steps for Method #1, except use the new icons instead of using “Format” etc in the 

menu. 
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Excel is a great tool for simplifying difficult mathematical and statistical chores.  Using the following 

data table as an example, several things can be shown. 

 A B C D 

1 5.129 3.261 3.67  

2 2.876 1.839 5.52  

3 3.573 2.248 8.25  

4 1.753 1.107 11.37  

To calculate the sum of column A in cell A5, the text in A5 would read:   =sum(A1:A4)   You can 

type the cell address or use the mouse to highlight the cells once the first parentheses has been typed. 

Type “Enter” after using an equal sign (=) using the mouse to click another cell changes the formula! 

To calculate the average of row 1, the text in D1 would read:  =average(A1:C1)   

To calculate the natural log, use:  =LN(A1), and base ten log is:  =LOG(A1). 
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The standard deviation of column A is calculated as:  =stdev(A1:A4).    

Copy a formula from one cell to another: drag the lower right corner of a cell down or to the right.
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